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What exactly is an iAdventure??
Introduction
What would Lewis and Clark have done differently if they were able to access unlimited information on weather
patterns and geology of North America? How would Gregor Mendel have changed his famous genetic experiments
on peas if he could instantly access the results of every scientific study ever published? How would Laura Ingalls
Wilder describe her childhood if her family could have used the Internet to order their supplies needed to build their
"Little House on the Prairie?" Perhaps these questions cannot ever be answered. Or can they? Welcome to
Learning with iAdventures! 

Why iAdventures?
Internet access has become a standard in schools in the last few years. At the same time, the volume and quality of
online resources has exploded, allowing access to up-to-the-minute data and vast collections of information and
primary documents. Clearly, this ocean of information is of significant educational value, but it is not always clear
how these resources can be smoothly integrated into classroom learning activities. The iAdventure concept was
developed as an activity structure, an easy way for teachers to create high quality Internet-infused lessons.
Students must be given opportunities to explore how computers and Internet access can be used to solve problems
and accomplish tasks. That is what an iAdventure (Internet Adventure) is designed to do.

What is an iAdventure?
An iAdventure is a problem solving activity in which students determine the direction and outcome of a content-rich
storyline, using resources available on the Internet, particularly resources providing real-world data and primary
documents. The activity is designed to help students discover how the characters could use access to unlimited
data and information (the Internet) to solve problems and make choices.

As students work their way through the story, they are faced with a series of dilemmas, in which choices must be
made. At these points, the teacher has provided links to Internet sites with real-world data, "primary" documents,
and other valuable web resources. Students visit these sites, collect data, read various documents, view video and
images, and interact with the activities. After analyzing the information, they make an informed decision about the
next course of action for their character. The outcome of the iAdventure is open-ended, often a complex product
created by the students themselves. Every student product should be different, based upon the knowledge and
interests of the students, and upon the choices they have made during the iAdventure.

The following is a brief example of a sample iAdventure.  This should give you a feel for a complete project:

iAdventure Example:
A science teacher has been trying to find a way to bring to life for her students the true nature of scientific discovery, by reading
stories about historical scientists. She decides to construct an iAdventure about the voyages of Charles Darwin to the Galapagos
Islands, as part of a unit on natural selection. Her goal is to create an activity that is enjoyable, teaches students important science
concepts, and illustrates to them how the availability of information online can be used to solve real problems. After creating her
iAdventure, she schedules three days of class in the computer lab (where there are at least enough computers for her students to
work in pairs).

Her students, working in pairs, begin by connecting to her iAdventure web site, then the student who has the role of Story Reader
(this student operates the computer as they work through the story) guides the pair through the opening storyline. They follow
Darwin through a portion of his early life leading up to his 5-year voyage aboard the Beagle. Eventually they reach the Galapagos
Islands, where they are faced with the same baffling biological puzzles that Darwin was faced with. Darwin, however, did not have
global access to unlimited information, as they do. Their first dilemma involves trying to decide if the unusual island animals
originated on the mainland or on the islands. Before making this decision (which will determine their future course of progress)
they visit web sites that provide actual data on ocean and air currents in the area and information on the various animals that live on
the mainland, including recent research on the genetic connections between the mainland and island animals. Links to these web
sites are provided by the teacher on the iAdventure pages. Based on data collected by the student with the role of Researcher (this
students operates the computer as they gather information from the web sites), they make a choice, which takes them in a specific
direction of the story-line.

The next dilemma the students are faced with involves the actual crew of the Beagle. The ship's captain is faced with low moral and
possible desertion. A choice must be made as to whether to navigate to the mainland to give the crew some much-needed time off
or to continue. The students visit web sites that have actual journal entries written by Darwin and some of the other men on the ship
(primary documents). They make a decision as to whether there actually was such a danger, based on these journal entries. Their
decision takes them in a specific story-line direction.

When students reach the third dilemma, which must be solved by additional analysis of primary documents and data, they then solve the final
problem, which involves creating a research journal by Mr. Darwin, detailing the many difficult decisions he had to make and problems he
had to solve.  This product will be shared with the class in
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Characteristics of Highly Effective iAdventures:
1. Students follow an engaging story about a character that faces real-world dilemmas, and
help the character resolve them by conducting research and creating a substantial product.

2. Students resolve dilemmas and create products based upon their interaction with the
richest types of resources on the web (real data that is updated frequently, primary
documents, interactive sites, and communication with others).

3. Students share their conclusions, justifications of their choices, and final products with
others in a culminating sharing event.



Anatomy of an iAdventure
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Creating an iAdventure with Mozilla Composer
(Version 1.7x – Macintosh and Windows)

Downloading the Template:
• Use your web browser to go to this address: http://warrensburg.k12.mo.us/iadventure/class
• Scroll down to the section called Helper Pages and select one of the templates to download.  These templates have been

compressed (either stuffed or zipped), so choose the one that your computer is capable of expanding.
• Click on the template of your choice.  This will download the file to your desktop (or your designated download folder).

Depending on your configuration, the file may decompress automatically.  If not, use a decompression utility to open it.  This
will result in a folder containing the template.

Editing the Template:
• Open the template folder.  You will see several HTML files (web pages), and a few images.  The starting web page for the

template is index.html.  You will open this page in Mozilla Navigator.  It may not work to double-click this file (your
computer may open it in Internet Explorer if that browser is available).  If it doesn’t work, open Mozilla, select Open File
from the File menu, then locate and select index.html.

• After it opens, pull down the File menu and select Edit Page.  This will open the page in Mozilla Composer.
• You will need to assign a page title to this page (not the same as the file name, which is index.html).  The page title is what

people see displayed at the top of their browser as they view your page.  Select Page Title and Properties from the Format
menu.  In the next window, next to the word Title, type the desired title for your page (such as the title of your iAdventure).
Click OK.  Now you can add content to your iAdventure page!

• To change the page’s background color, click the Format menu and select Page Colors and Backgrounds.  Select Use Custom
Colors, then click on the button next to Background.  Select the background color you want.

IMPORTANT POINT:  In Composer there are two ways of viewing web pages.  When editing your page, it is in Edit mode.
You can also preview your web page in a web browser.  To do this, click on the Browse button (it looks like a navigating
wheel).  This opens your page in Mozilla Navigator.  You cannot make changes in Navigator.  You must return to Composer to
edit the page.  The Browse option is important because you should regularly look at your page in a real web browser to make
sure that it “works” properly.

Adding and Editing Text:
• The template provides some text to get you started, but you will want to replace all of this text with your own.  Highlight the

text that you want to replace and then type your own text.
• Many of the text formatting buttons are similar to what you would use in a word processor.  You can center the text, resize it

somewhat, and select a style, such as Bold, Italics, or Underline.  You can change the color of your text by highlighting it and
clicking the Font Color button (next to the font size button).

• It is possible to select a different font.  To do this, pull down the Format menu to Font, then a submenu of fonts appears.  But,
if the viewer’s computer does not have the font you choose, the they will not see your chosen fontr.  If you do choose another
font, make sure it is one that is very common, such as Arial, Comic Sans, Verdana, Chicago, Courier, Geneva, Helvetica,
Monaco, New York, Palatino, Times, or other font that is common.

Adding and Editing Images:
• By far, the best way to add images to your web page is to prepare them first, save them as GIF or JPEG images, and then

place them in your web page folder.  Then add them to your web page from this folder.  Images can be edited and
converted to GIF or JPEG with an image-editing program such as Adobe Photoshop Elements.  If you are obtaining pictures
from the Internet, perhaps from a web site that already exists, they will already be in the GIF or JPEG format.

• To get a picture from an existing web site, locate a picture that you like, then Right-click (Control-click on a Mac) on the
picture.  In the menu that appears, select Save Image as… or Download Image to Disk and save it to your folder.  Then it can
be inserted from your folder into your web page.  Please keep in mind that some pictures on the Internet are copyrighted!

• To insert pictures on your page, click to place the cursor where you want the picture.  Then click the Image button (it has three
small shapes on it, a circle, triangle, and square).  In the resulting dialog box, click the Choose File button.  Locate the image
file you want to insert (it should be in your page folder!) and click Open.  Then click OK.  This places the image into your
web page at the spot where the cursor was.

• To center any image on your web page, click to the side of the image to place your cursor on the same line, then select the
Center button (this is the same method as centering selected text).

• To edit various attributes of an image on your web page, such as borders and text-wrap, double-click on the image to open the
Format window (or Image Properties windows).  Make sure the Appearance tab is selected at the top of this window.  You
can experiment with the controls here or read about them in the Help files.



Using Tables to Help with Page Layout:
It is often desirable to have images, text boxes, etc. on the left side of your web page, and something else on the right side.  You
can, for instance, insert a table that is one row and 3 columns wide, place an image in the left cell, center some text in the
middle cell, and place another image in the cell on the right.
• To insert a table, place the cursor where you want it, then click the Table button (a small grid with 3 columns and 2 rows).

This will open the Insert Table dialog box.  Type the number of rows and columns you want in your table.  You can also
make it so the table does not have a visible border around each cell (next to Border Line Width, set the number of pixels to
zero).

Creating or Changing Internal Links:
The template already has most of the links between pages (just re-type the text of each link to make them say what you want),
but you will likely need to change or create some of your own internal links.
• Highlight the text (or image) you wish to serve as a link to another page.
• Click on the Link button (it looks like a small chain with 3 links).
• In the dialog box that opens, click on the Choose File button.
• Locate the page you want to link to, select it, and click Open, then click OK.  This makes the text into a link that web page.

Adding Links to a Remote Sites (External Links):
• You can also link text (or an image) to any other web page that is on the Internet.
• Highlight the text (or image) you want linked, then click the Link button (it looks like a chain with 3 links).
• In the resulting dialog box, type or paste in the URL (web address) of the remote site (be sure to include the http:// at the

beginning), then click OK.  This links the text or image to the remote web address.

Uploading Your Web Page to a Web Server:
• Mozilla Composer has a built-in feature that allows you to upload your pages and images to a web server.
• This can be done only if you have an FTP account on the web server, and you must know the address of the server and your

FTP username and password for your account.  You can upload your iAdventure to your own school district’s web server, if
there is one available.

If you do not have a web server available for your use, you can send me your completed iAdventure and I will
examine it and place it on the Learning with iAdventures site on the Warrensburg Schools web server.  The easiest
way to do this is to Zip up your iAdventure folder (compress it), and then email it to me as an attachment.  You
can also burn it on a CD and mail the CD to me.  Here is how to do this:
My email address: ssmith@warrensburg.k12.mo.us
My snail mail address:  Stan Smith, Warrensburg R6 Schools, 438 East Market, Warrensburg, MO 64093

• When you are ready to upload your page(s) and the files that are associated with it (remember, all the images must be there in
the same folder), do the following:

• Make sure your main index page is open and visible in Composer, then click the Publish button (the 4th button from the left in
the top row of buttons, it looks like a slanted page with three lines under it).

• At the top of the Publish window that opens, click on the Settings tab.  Type a site name (anything will work for this).  Type
the web server address in the space below where it says Publishing address.  In front of the server address, type ftp://

Example:     ftp://warrensburg.k12.mo.us

You do not need to type anything for the HTTP Address.
• Under Login Information, type your Username and Password that were given to you.
• Now click on the Publish tab.  Make sure there is a checkmark next to Include images and other files.  Everything else here

should be okay.
• Click the Publish button.  If everything is correct, a box will open that shows the progress of your upload.  If there are images

on this page, the images will be uploaded also, and a list of the files will appear, with green checkmarks next to each one that
was successfully uploaded.

• If you have other HTML pages (web pages) as part of your site, they must be uploaded in the same way.
• Once you have uploaded each page the first time, all you need to do is click the publish button from now on.
• You should check your uploaded web page by going to your web site with a web browser.

Once you have your FTP account set up, you can update and re-upload your iAdventure whenever necessary!


